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Mastering Windows
Media Player 11

How Microsoft’s New Media Player Is the
Master of Its Domain

It wouldn’t seem like a new version of Windows if Microsoft
didn’t pony up a new version of Windows Media Player
(WMP) to go with it. Vista is no exception—it includes ver-

sion 11 of Windows Media Player as its dice-slice-rip-play
multimedia powerhouse. With version 11, WMP offers big
improvements in usability, support for portable media players,
the Xbox 360 game console, CD and DVD burning, Internet
access, network support, and file synchronization.
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WMP 11’s Play Controls
When you start Windows Media Player, the Library view is dis-
played by default. The newly uncluttered Explorer-style interface
uses a menu along the left side of the WMP display for selecting
different views of your digital library (see Figure 8.1). The play
controls are centered along the bottom center of the display, for
easier access when running WMP 11 in a windowed mode.

WMP 11 enables you to move quickly from one level to another
of a menu without excessive scrolling. In Figure 8.2, for example,
you can click on either the navigation pane on the left or on the

menu tree shown above the current item. This tree works just like
the breadcrumb feature found in the Windows Explorer, except the avail-
able options are specific to Media Player. Note that by using the menu tree
above the current item that some options can be selected that are not
available from the left-hand menu, such as contributing artist, composer,
parental rating, store, and folder.

NOTE

After you configure WMP,

you can start it directly

from the QuickLaunch tool-

bar, next to the Start but-

ton, or from the Start

menu. However, the first

time you run it, you must

run it from the Start menu.
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Figure 8.1
WMP 11 provides an uncluttered interface with fast access
to major features.
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Figure 8.2
Use the pull-down menu above the current selection for additional options.

Just like when using a web browser, you can use the Back and Forward
arrow buttons on the top-left corner of the window to access previously
viewed items in the Media Player window and then return to a more
recent view.

Playback Controls
In WMP 11, the playback and appearance controls have been significantly
redesigned from previous versions. These controls are located at the bot-
tom of the screen, but the playback controls (refer to Figure 8.1) are now
centered and offer easier-to-understand designs than in previous WMP
versions.

� You can also use the Play menu to play media. See “Using the Now
Playing Menu,” p. 191, this chapter.
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and which ones you’d prefer to leave
available for a different program.

The following table lists the file types that
WMP 11 supports. Use it to help you plan
which file types you want WMP 11 to play,

Multimedia File Types Supported
by Windows Media Player 11

Media Type Extension Notes

Video .mpv2, .mpg, .mp2v, .mpa, .m1v, .mp2, MPEG movie
.mpe, .mpeg, .avi Windows video

Audio .wav Uncompressed audio file
.aiff, .aif, .aifc AIFF audio
.au, .snd AU audio
.midi, .rmi, .mid MIDI audio sequence
.cda CD audio track

Audio/Video .asf, .wmv, .wm Windows Media A/V

Playlists .wmx, .wpl, .wvx, .m3u Windows Media playlist
Shortcut .wax Windows Media 

WMP Skins .wms Skin file
.wmz Skin package

Protocols for streaming .MMST Streaming using TCP
Windows Media files .MMSU Streaming using UDP

.MMS Streaming

Note that Apple’s QuickTime A/V format is
not supported by WMP 11; to get a player
for QuickTime, visit http://www.apple.com/
quicktime/win.html. To play back the AAC
format used by Apple’s iPod portable
media players, use Apple’s iTunes (http://
www.apple.com/itunes/). Sony’s ATRAC
audio format is not supported by WMP 11;
use an ATRAC-compatible media player
and companion software for playback.
See http://www.sony.net/Products/ATRAC3/
for details.

You can also view digital photos in com-
mon files types such as JPEG, TIFF, and
others with WMP 11. Select Pictures as the
media type or open the Library menu and
select Pictures to view pictures in WMP 11.
You can organize pictures by rating, by
date taken, or by keyword tags. However,
for more picture playback and editing
options, use the Windows Photo Gallery
(see Chapter 9 for details).
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Command Keyboard Shortcut

Toggles Play/Pause Ctrl+P

Previous track Ctrl+B

Next track Ctrl+F

Rewind Ctrl+Shift+B

Fast forward Ctrl+Shift+F

Shuffle Ctrl+H

Repeat Ctrl+T

Increase volume F10

Decrease volume F9

Mute audio F8

Enable lyrics, captions, and
subtitles (if available) Ctrl+Shift+C

Eject media Ctrl+J

Command Keyboard Shortcut

Open media Ctrl+O

Open URL Ctrl+U

Close media Ctrl+W

New playlist Ctrl+N

Add selection to library F3

Full mode Ctrl+1

Skin mode Ctrl+2

Classic (top-level) menus Ctrl+M

Refresh display F5

50% video size Alt+1

100% video size Alt+2

200% video size Alt+3

Help F1

Don’t be a mouseaholic! Give your mousing arm a rest and use the keyboard shortcuts
in WMP 11 instead. Here’s a comprehensive list of each shortcut and what it does.

Keyboard Shortcuts in WMP 11

Classic Menus
By default, WMP uses a so-called “breadcrumb” and drop-down menu sys-
tem. However, if you prefer the traditional menu bar (File, View, Tools, and
so on), relax: it’s not gone for good. WMP 11’s traditional menus can be
accessed in one of two ways: Right-click the lower-left corner of the display
or press the Alt key on your keyboard and select Show Classic Menus. In
any case the menus you can choose from include the following:

� The File menu can be used to open media or a specified URL, close
media, save the current media file, create playlists, add selected media
to a library, examine the properties of the currently selected media file,
work offline, view recently played files, or to exit WMP 11.
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� The View menu offers a huge number of options for adjusting the
appearance of WMP 11 and how it plays media files. Using the View
menu, you can select full or skin mode; go to other menus for the cur-
rent media type; go to URGE or other online music stores; configure
the Now Playing layout; download plug-ins; configure enhancements;
select DVD features; view statistics, choose information (columns) to
display for the current media type; and adjust video playback size.

� For more information on working with skins, see the sidebar “WMP’s
Skin Modes,” p. 181, this chapter.

� For more information on working with visualizations, see “Using
Visualizations,” p. 192, this chapter.

� For more information on playing video, see “Playing Video in WMP
11,” p. 210, this chapter.

� The Tools menu provides a quicker way to download visualizations,
plug-ins, and skins, enable or disable plug-ins, and it provides easier
management of media information and media usage rights. It also
gives you fast access to the multi-tabbed Options menu. Use Tools as
an alternative to wading through other menus.

� The Help menu provides a mixture of local and Internet-based help
options, as is typical with recent Microsoft products. Click Windows
Media Player Help or press F1 to bring up a hyperlinked help page with
links to online resources. Click Windows Media Player Online to go to
the official WMP page at Microsoft’s website. Click Check for Updates
to check for and install updates (when available); the Windows Media
Configuration Manager pops up to let you know whether there are
updates you can install. Unfortunately, there are no links to Options
tabs or a repair tool in case WMP 11 gets hosed.

Feature Rating: Help

� The Play menu provides a complete range of play controls, including
shuffle, repeat, audio and language tracks, volume, ejecting media,
previous/next, and rewind/fast forward. The options available vary
according to the media being played.
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to open the Microsoft Skins for Windows
Media Player web page. Browse skins, and
click the Download link for each skin you
want to try. To permit download, click Yes or
Permit on any security warnings displayed.

Click View Now to use the skin as soon as it
is downloaded, or click Close to leave it
stored for later use. To revert to full mode
after using a skin, right-click the skin and
select Switch to Full Mode from the right-
click menu. Follow the procedure in the pre-
ceding paragraph to download more skins.

If you like customizing your music player’s
appearance (and shrinking its onscreen pres-
ence down to a more manageable size),
you’ll love skinning WMP 11. Although WMP
11 includes only a couple of optional skins,
including Corporate, which resembles the
minimal interface used by old versions of
WMP, and Revert, which is a reduced-size
player window useful for digital music (and
a carryover from WMP 10, by the way), you
can download many more skins.

To see more choices, click Skin Chooser
from the View menu and click More Skins
from the Skin Chooser menu (see Figure 8.3)

WMP 11’s Skin Modes

Uses selected skin

Opens Microsoft skin

download web page

Deletes selected skin

Preview of selected

skin

4

3

2

1

Figure 8.3
WMP 11’s Skin Chooser menu after downloading optional skins.

WMP 11 can use the same skins as WMP 10 and earlier versions, so you
can recycle your favorite skins. To learn how to make your own skins,
follow the link to the MSDN website from the Skins for Windows Media
Player web page.

2

1

3
4
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Some plug-ins have two or more compo-
nents. In such cases, make sure all com-
ponents are checkmarked. To disable the
plug-in, click the entries to clear their check
marks. To re-enable the plug-ins, click the
entries again.

Before you download a plug-in for WMP 11,
make sure that Media Player doesn’t already
have the feature you want. WMP 11 includes
a number of built-in enhancements to
improve audio and video playback and other
features. To select an enhancement, select
View, Enhancements, Show Enhancements,
and select an enhancement from the menu
(see Figure 8.4).

There are many types of plug-ins you can
get to improve WMP 11:

� Audio effects (DSP)

� Rendering

� Other types

To see what’s available, click View, Plug-ins,
Find On the Web, which opens the Microsoft
Plug-ins for Windows Media Player web
page. Follow the web browser and security
prompts to download, run, and install the
plug-in you select.

After you install a plug-in, it appears on the
plug-ins menu and also in the Tools menu.

Downloading and Using Media Player
Plug-ins and Enhancements

Check to show

enhancements

Selected

enhancement

User interface

for selected

enhancement

3

2

1

Figure 8.4
Enabling the Graphic Equalizer enhancement.

The enhancement’s user interface shows up in the same lower portion of the display as
a plug-in uses. Note that WMP 11 supports the use of only one plug-in or enhancement at
a time.

2

3

1
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Configuring WMP 11’s Options
Several menus shown earlier in this chapter include their own
Options menus. When you select Options in any menu of WMP
11, you open the corresponding tab of the Options dialog. 

While most of the options tabs are similar to those found in
WMP 10, some of them include some new features:

� The Library Options tab (see Figure 8.5) includes new options
for sharing media over a home network and for auto-leveling
of audio files.

Figure 8.5
Manage media sharing, ripped music, and media folders with the
Library Options tab.

� For more information about setting up Media Sharing,
see “Media Sharing and Your Home Network,” p. 214, this
chapter.

� The Privacy Options tab (see Figure 8.6 A) includes a new
option for downloading usage rights automatically when you
play or sync a file. It’s enabled by default, but the default set-
ting means you won’t be notified of problems. I recommend clearing

TIP

Because the Options dia-

log is multi-tabbed, you

can access any tab at

any time. This makes the

Options dialog an excel-

lent alternative to thread-

ing your way through

WMP 11’s many menus to

manage media and play-

back settings.

WARNING

By default, media you

delete from your library is

also deleted from the com-

puter. Make sure that any

library files you want to

delete are backed up else-

where, or clear the Delete

Files… check box. This is

especially important if

you enable the option to

include media played from

removable drives or net-

work folders in your library

on the Player Options tab.

If you delete network files

from your library with the

default setting for deleting

library files enabled, you

could remove them from

another user’s system!
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this check box as well as the Automatically check if protected files need
to be refreshed check box.

� The Security tab (see Figure 8.6 B) now permits script commands and
rich media streams to run inside a web page

� The Player tab (see Figure 8.6 C) includes a new option for starting
WMP in mini-player mode. There’s also an option to start the mini-play-
er automatically whenever a specified filename is activated. For exam-
ple, to play back voicemail messages (often stored as “voiceatt.wav”).  

Privacy

Security

PlayerC

B

A

Figure 8.6
Options tabs with new features.

The other options tabs you can use to configure
Media Player require a bit more explanation. The
Rip Music options tab, for example, provides a
one-stop destination for configuring where to store
and how to rip your music. Using this dialog saves
time over working with the normal Rip menu.

You can now select two uncompressed (lossless)
ripping formats: Windows Media Audio Lossless
and WAV, and four compressed (lossy) ripping

A

B

C

WARNING

You can always convert a

lossless format to a lossy

format to save space on a

portable media player (use

the Device Options dialog’s

Advanced settings to con-

figure conversion settings).

Keep in mind that you can

never restore the audio

quality lost when you use

lossy audio ripping.

11_0789735865_ch08.qxd  7/27/07  10:09 AM  Page 184



MAXIMUMPC 185

MASTERING WINDOWS MEDIA PLAYER 11

formats: Windows Media Audio, Windows Media Audio Pro,
Windows Media Audio (variable bit rate), and MP3. These addi-
tional options make it easier to select the best format for your
needs and better support the wide range of digital music-capable
devices on the market.

To determine the default settings used for each type of digital
audio, select the format and look at the audio quality pointer at
the bottom of the dialog. If you prefer a higher-quality default for
any (or all) file formats supported by WMP, use this tab to adjust
them. 

Use Table 8.1 as a quick reference to each recording format sup-
ported by WMP 11. The highest bit rate in each format provides
best quality but also the largest file size.

The Devices options tab, which provides shortcuts to the proper-
ties sheets for your optical drive(s), display, attached portable
media devices and speakers, is unchanged from WMP 10’s ver-
sion. However, for better performance and video quality, consid-
er changing many of the defaults on this menu. Here’s what I rec-
ommend:

� If your system slows down significantly when you convert
video, disable the Allow Video Files to Convert in the
Background option.

� If your system has a dual-core or quad-core processor or two or more
physical processors, try enabling both the video and audio background
conversion options. These systems handle multitasking far better than
single-core processors.

� If you see jagged lines or other types of distortion when you convert
video, enable the Deinterlace… option.

� For best video quality, enable the Choose Quality Over Speed… option
(which increases conversion time).

� If you’re short of space on your primary hard disk (less than 1GB free)
and you have a second physical hard disk with a lot of space, change
the default location of the Transcoded Files Cache folder to a folder on
that hard disk. For example, if your second physical hard disk is identi-
fied as E: drive, create a folder called Transcoded Files on that hard
disk. Create a folder for each user in that folder. You can then change
the location for user Marcus (for example) to E:\Transcoded
Files\Marcus. When you create the folder Marcus, use the Security tab

WARNING

Although the default

128Kbps WMA file format

setting isn’t necessarily a

bad choice, this is your
music collection we’re

talking about. Do you really

want to settle for ade-

quate? (And before you

answer, consider the time

penalty you’ll pay re-

ripping your entire collec-

tion, should you change

your mind and want to rip

to a better quality.)

Classical music and sym-

phonic movie soundtrack

fans in particular, might

prefer different formats or

higher bit rates.
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Table 8.1 WMP 11’s Recording Formats

Copy 
Recording Supported Protection 
Format Extension Bit Rates Option Notes

Windows Media Audio WMA 48Kbps Yes Use higher bit rates for classical 
64Kbps and symphonic music; lower bit 
96Kbps rates for spoken word or to 
128Kbps1 create smaller files.
160Kbps
192Kbps

Windows Media WMA 32Kbps Yes Supports up to 5.1 surround
Audio Pro 48Kbps audio; provides comparable 

64Kbps1 quality to standard WMA at half
96Kbps the bit rate; also optimized for
128Kbps Windows-based smartphones.
160Kbps
192Kbps

Windows Media Audio WMA 40–75Kbps Yes Some older WMA-compatible 
Variable Bit Rate (VBR) 50–95Kbps players may not be able to handle

85–145Kbps VBR recordings.
135–215Kbps
240–355Kbps

Windows Media Audio WMA 470–940Kbps2 Yes Performs no file compression
Lossless for quality identical to original; 

creates very large music files.

MP3 MP3 128Kbps No (Hooray!) Works with virtually any portable
192Kbps music player.
256Kbps
320Kbps

WAV WAV 1411.2 Kbps No Performs no file compression for
quality identical to original; creates
very large music files (larger than
WMA lossless); best choice for 
audio that needs additional editing
before use.

1 Default bit rate in Windows Media Player
2 Bit rate automatically adjusted during recording

to set the properties for the folder so that Marcus is the only user with full access to
the folder.
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To clean up outdated cache files, click Delete Files.

To configure synchronization and conversion options for your
portable media device, select it from the Devices tab and click
Properties. Use the Sync tab to configure when file synchroniza-
tion starts and to reserve space on the device for other pro-
grams. Use the Quality tab to specify the quality level for music,
TV, and video files synched to the device.

Use the brand-new Burn options tab, shown in Figure 8.7 A, to
control burn speed, audio leveling, media information storage
settings, and downsampling conversion to stuff more informa-
tion on a disc (not recommended, but you have the option if you
want it).

By default, files on CDs or DVDs burned with WMP 11 are organ-
ized by media type (for example, \Music\Artist\Album, \TV, \Video,
and \Picture), with folders known as \Unknown Artist and
\Unknown Album used for media that lack this information. If
you clear this option, all media files are stored in the root folder
of the media.

Enabling the option to convert media to a lower bit rate also
changes MP3 and WAV files into WMA format, slows down the
burn process, and reduces music quality (how much depends on
the bit rate you select and the type of music you’re converting).
It does, however, allow you to squeeze more media content onto
the disc.

Finally, there’s the Performance tab (see Figure 8.7 B), which offers
new features to support WMP 11’s new DVD playback features.

Consider adjusting the default settings if you have the following problems
with media playback:

� If you are not satisfied with the quality of streaming media from the
Internet, try setting the connection speed manually.

� If you frequently have congestion problems that cause jerky playback of
streaming media, try adjusting the Network Buffering setting manually,
increasing it from the default of 5 seconds.

� If audio and video are frequently out of sync with each other, enable
the Drop Frames… option.

TIP

To find out how many

physical hard disks your

system has (and the drive

letter used for the sec-

ond drive, right-click

Computer and select

Manage. Open Storage,

Disk Management, and

the hard disks and opti-

cal drives in your system

are displayed. The first

hard disk is displayed as

Disk 0. If you have two or

more hard disks installed,

the second hard disk is

Disk 1, and so on. Use a

drive letter on Disk 1 or

higher to speed up

transcoding and other

functions, including

paging files.
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� If you are not satisfied with playback speed or smoothness
when playing DirectX or DVD video, select the Enable DxVA
Video Acceleration option.

Burn

PerformanceB

A

A

B

Figure 8.7
Option tabs featuring support for DVD burning and playback.

NOTE

By default, quality levels
for files transferred to a
portable device are select-
ed automatically. If you
override this setting and
set the quality level your-
self, you may use more
space on your player than
the default would without
hearing (or seeing) a cor-
responding increase in
quality from larger files.
Let’s face it: tiny earbuds
are no match for a 5.1 or
7.1 surround audio system,
and a 320×240 screen can’t
compete with a 21-inch
widescreen LCD display
(let alone a DLP or plasma
display!). 
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Working with Audio in WMP 11
WMP 11 includes many new and improved features for audiophiles, includ-
ing an easier-to-use interface, new ways of organizing your music, more
ripping options, better file synchronization, and others.

WMP 11 gives you a bunch of options for getting down with your favorite
tunes. Select an audio track in Library view and click the Play button, and it
starts playing immediately.

For other play options, right-click a tune to view play options:

� Play—Plays selected track only

� Play All—Plays all tracks in selected album

� Add to Now Playing—Adds selected track(s) to Now Playing playlist

� Add to—Adds selected track(s) to a specified playlist

Music Library Viewing Options
WMP11 makes it easier to find the right music for the mood than
ever before. In Library mode, you can select any of the following
views to instantly organize your library:

� Recently added—Displays the most recent additions to your
digital music collection with the same display options used
by the Songs view.

� Artist—Displays albums in order by artist name, including
album art, number of songs, average song rating, and total
time (in minutes) for each album (see Figure 8.8 A).

� Album—Displays albums in order by album name, including
album art and contributing artist/group.

� Songs—Displays the songs in each album in order by artist
name, and includes album art, track number, duration
(minutes:seconds), genre, album date, song rating, and
contributing artist (see Figure 8.8 B).

� Genre—Groups albums by genre, average song rating, and
total time (in minutes). 

� Year—Displays albums sorted by decade, and groups albums
produced in a particular year together, including album art,
date, total time (in minutes), and average song rating (see
Figure 8.8 C). 

NOTE

First Names Only

The Artist view sorts

albums by the first name of

the artist or group. Thus,

Ludwig van Beethoven is

listed before The Posies.

TIP

Windows Media Player

11, like other parts of

Windows Vista, stacks

related items together

(see the year 2005 in

Figure 8.8 C for an exam-

ple). When more than

one item is visible in a

stack, double-click the

stack to see all the

stacked items.
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� Ratings—Displays star ratings you assign (My Ratings) and
Auto Ratings (based on how often you play an album. Click
each star to see which songs received the rating.

Artist view

Songs view

Year viewC

B

A

Figure 8.8
Various Music Library views.

To choose additional views (contributing artist, composer, parental rating,
online stores, and folder), click the Library icon in the left pane.

Feature Rating: Music Library

Searching for Media with WordWheel
WMP 11 features a search tool powered by Vista’s WordWheel search tech-
nology in the upper-right corner of the main program window. Before
entering search text, select the view to search from the left-hand menu. If
you select Library or Playlists before entering search text, WMP 11 displays
artists, album titles, or song titles that match the text entered. Note that
WMP 11 also searches your music store (if any) for matches.

To search for specific artists, songs, or albums, highlight the applicable
view under My Library before entering search text.

In Figure 8.9 A, the search text “Be” was used after selecting Library,
resulting in matches with two artists, two albums, and eight songs in the

A

B

C
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local library. To see the matches, click the underlined links. Figure 8.9 B
shows the results for the same search text if the Songs view is selected,
again resulting in eight songs, but this time across three albums.

Figure 8.9
Searching for media with WMP’s WordWheel search match feature.

The Search tool can also be used to locate any other type of
media that WMP 11 supports, such as pictures, video, recorded
TV, or other media.

� For more information about using the Playlist feature, see
“Creating Playlists,” p. 200, this chapter.

Feature Rating: Search

Using the Now Playing Menu
The Now Playing menu, at its core, does exactly what it says. It
shows you what’s currently playing, along with any other music you have
in your current playlist. However, it allows you to select what enhance-
ments, visualizations, and plug-ins you want to use while your music is
playing (see Figure 8.10).

When Show Enhancements is checked, the selected enhancement is dis-
played. When Show List Pane is checked, the current song list is shown on
the right side of the WMP window. As Figure 8.10 shows, you can use an
enhancement while also enjoying visualizations.

Library view

Songs viewB

A
A

B

TIP

After you find the media

you’re looking for with a

WordWheel search,

select it and drag it to the

Playlist pane for an

instant playlist.
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Figure 8.10
The Now Playing menu with enhancements, the list pane, and visualiza-
tions enabled.

The Plug-ins menu selection provides yet another way to download, select,
or enable a plug-in. Selecting Options opens the Plug-ins options tab.
Selecting Visualizations opens the Visualizations menu shown in
Figure 8.10, which is detailed in the next section.

Using Visualizations
Earlier versions of WMP pioneered the use of visualizations, abstract pat-
terns or animations that change as music plays. WMP 11’s installed choices
are similar to those provided by WMP 10, including

� Album Art

� Alchemy

� Bars and Waves

� Battery (the default)

Bars and Waves offers several variations, whereas Battery offers more
than two dozen variations, including a Randomization option. To see the
selected visualization while your music plays, click the Now Playing drop-
down menu and open the Visualizations submenu (refer to Figure 8.10).
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If you want more choices, click Download Visualizations. This
opens the Microsoft Visualizations for Windows Media Player
web page.

Downloadable visualizations include adaptations from popular
live-action and animated movies, slideshow players with animat-
ed transitions, as well as abstract animations similar to those
packaged with WMP 11.

To use a visualization, click Download and follow the onscreen
prompts to Run or Open the visualization file when prompted. If
the User Accounts Control warning dialog box appears, click
Allow.

Now, you can go back to Windows Media Player, select the visu-
alization you downloaded, select an option if provided, and open the Now
Playing menu to see it in action.

In some cases, you may need to configure the visualization before you can
use it. To configure the selected visualization, select Options from the Now
Playing menu to open the Plug-ins Options tab. Select Visualization from
the category menu, then select the visualization and click Properties to
open the properties sheet for the visualization (see Figure 8.11). 

TIP

WMP 11 can use the

same visualizations as

WMP 10, so you can

recycle your favorite

visualizations. To learn

how to make your own

visualizations, follow the

link on the web page to

the MSDN website.

Figure 8.11
Configuring the background image settings for the optional Picture Viz II
visualization.
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Ripping Music with WMP 11
To start the ripping process with WMP 11, select Rip from the
top-level menu and insert a music CD when prompted (see
Figure 8.12). By default, WMP 11 starts playing and ripping the
CD as soon as you insert it if you are in the Rip menu (if you’re
not currently playing music). To stop music playback to enable
faster ripping, click the Stop button in the playback controls at
the bottom of the screen. By default, WMP 11 rips all tracks of
the CD using Windows Media Audio (WMA) format at 128Kbps.

Fortunately, if you don’t like WMP 11’s rip defaults, you can
change them! You can

� Select the tracks you want to rip

� Select the digital music file format (MP3 or WMA only)

� Select the bit rate

� Specify whether to use copy protection

TIP

Enjoy your favorite pic-

tures while WMP 11

plays your favorite

music! Download the

Picture Viz I or Picture

Viz II visualizations. With

Picture Viz I, you must

specify a single folder as

the picture source.

Picture Viz II lets you

select a folder that con-

tains subfolders (it uses

the current user’s

Pictures folder as the

default) and features new

and improved animation

transitions. Both support

JPEG, BMP, PNG, TIFF,

EXIF, and TGA image

formats.

Ripping progress

bar

Toggles ripping

start/stop
2

1

Figure 8.12
Ripping a movie soundtrack album with WMP 11.

1

2
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To prevent a track from being ripped, clear the check box next to
the track. If you only want to rip a few tracks from the album,
clear the check box above the track names and then check each
track you do want to rip separately. Click Start Rip to convert all
tracks into the current format and bit rate.

Open the Rip menu to select format and bit rate. Click More
Options to open the Rip Options menu.

� For more information about formats and bit rates, see
“Table 8.1 WMP 11’s Recording Formats,” p. 186, this
chapter.

To select a bit rate for the current rip session, click Bit Rate from the Rip
pull-down menu and choose the desired bit rate from the menu. The Rip
pull-down menu also provides selections for ripping a CD as soon as it’s
inserted and ejecting a CD after it has been ripped.

Jens Adrian has a great comparison of different audio formats and bit rates
in his Compare Digital Audio Formats article, available at http://www.litex-
media.com/article/. 

NOTE

There’s absolutely no rea-

son to enable copy protec-

tion when you rip CDs to

any of the WMA formats.

None—zero—zip—nada.

removal, and can use a wide variety of
encoders (which are not included in the
EAC download). EAC is powerful, but com-
plex, with advanced configuration requir-
ing knowledge of using a command-line.
DOS fans may cheer, but there’s help for
the rest of us.

To learn more about EAC, including where
to find wizards to make using it easier, rec-
ommended command-line options, and
sources for the recommended encoders,
see The Coaster Factory’s Exact Audio
Copy Quickstart manual at http://users.
pandora.be/satcp/eac-qs-en.htm and the
Exact Audio Copy Guide from http://www.
teqnilogik.com/tutorials/eac.htm.

Although WMP 11 does an acceptable job
of ripping music from scratch-free CDs, it’s
not designed to handle problems caused
by scratched or dirty CDs or pops and
other noise in analog music sources
(including CDs created from old analog
recordings). And, you can’t choose what
encoder to use. If you’re looking for a bet-
ter way to convert your CD and LP collec-
tions into digital format, make sure you
give Exact Audio Copy (EAC) a try. EAC is
a freeware program available from
http://www.exactaudiocopy.de/. EAC is
designed to handle problems caused by
less-than-perfect music CDs. It provides a
huge number of extraction options,
includes track editing and noise and pop

Better Ripping with Exact Audio Copy 

Feature Rating: Audio Ripping
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Retrieving and Editing CD Information
You can edit “tag” information for a music CD before or after you
rip it. This information can be as basic as artist, album title, and
track title, or it can be as expansive as the release year, genre,
composer, and much more (how much of a fanatic are you about
your music?). Whether you intend to rip a handful of tracks or a
virtual mountain of them, there’s no reason not to take advan-
tage of the track tagging feature to make sure that track informa-
tion is complete and correct. By reviewing and editing track and
album information, you help organize your music collection and
make it easier to find the music that matches the mood.

Before editing incomplete or incorrect information, right-click any
track and select Find Album Info. An Album Info dialog appears
that attempts to match what it knows about your selected track
(from its tag information) to its own online music database.

If Media Player has enough to work with, it’s likely to come up
with a short list of potential albums that includes the one for
your track. If you find a match, simply select it and click Finish.
Media Player will apply all known information about that album
and its tracks to your music files, including the album’s cover art
(if it’s available).

If you can’t come up with an exact match, however, click the Edit
button from the Album Info dialog to add or correct the album

information (see Figure 8.13). This information is shared, by default, with
WindowsMedia.com so that future searches for this album (by you or other
users) will generate a match. When you’re finished adding information
about the track or album, click Finish to send the information to
WindowsMedia.com and apply it to the track tags for your music files.

Tag information you have stored for your individual music tracks may not
be complete or accurate, especially for older albums. To view or edit tag
information, right-click the track and select Advanced Tag Editor. This
opens the Track Info tab shown in Figure 8.14 A.

NOTE

The accuracy of the

results you get from the

Find Album Info feature

really depends on having

at least an accurate track

title. It also helps to have

the artist or album in place. 

TIP

Don’t assume that the

album information stored

in the Windows Media

database is correct.

Musical genres, track

information, and album

art can be missing or just

plain wrong. 
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Figure 8.13
Editing genre and track information before ripping the album.

� PNG (.png)

� GIF (.gif)

View the image file in Vista’s Photo
Gallery Viewer, right-click it, and select
Copy.

In WMP 11, select a view that shows
album art. Right-click the album art or
placeholder icon you want to change and
select Paste Album Art.

If the album art for your CD is incorrect or
missing, download or scan the album art.
Reduce it to a size of about 200×200 pixels
and save it in one of the following for-
mats:

� JPEG (.jpg)

� TIFF (.tif)

� Windows Bitmap (.bmp)

Making Your Own Album Art

Use the Track Info dialog to edit the album title, select the correct genre,
select a mood (mainly useful for Pop/Rock/Jazz music), specify the beats
per minute, key, and other information useful for serious (a.k.a. obsessive)
music aficionados.

Click the Artist Info tab to edit artist, lyricist, composer, conductor, and
other information about the track (see Figure 8.14 B).
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Click the Web Sites button to add or edit URLs for the audio file,
artist, audio source, and other useful sites.

Click the Lyrics tab to add lyric text to a track. The lyrics can be
displayed during playback. If you want to synchronize the lyrics
to the music, click the Synchronized Lyrics button to open a spe-
cial editing dialog. Use the sliders on the musical timeline and
the Play/Stop toggle button to synchronize the lyrics to the
music. Click OK when finished. 

To see the lyrics while you play the music, press Alt, open the
Play menu, select Lyrics, Captions and Subtitles, and select the

language and style desired. Media Player then displays the lyrics
in the Now Playing view.

Editing track info

with the

Advanced Tag

Editor

Editing artist and

composer

information

B

A

Figure 8.14
Using the Advanced Tag Editor to edit information about the truck.

You can also open a track’s properties sheet to see the information stored for
it, select Properties from the right-click menu. This opens a three-tab proper-
ties sheet. The default, is the File tab, which lists baseline track information
such as length, bit rate, media type, and so on. For artist, title, album, and
other information, click the Content tab. The third tab, Media Usage Rights,
is blank if you ripped your own albums and did not copy-protect them. If
you copy-protected the songs you rip or if you purchased digital rights man-
aged (DRM) media online, such as downloads from an online music store,
this tab displays media usage information (see Figure 8.15).

TIP

You can use the

Advanced Tag Editor to

edit a track while you’re

playing it. Use this fea-

ture to make it easier to

determine the mood of

a piece.

A

B
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Figure 8.15
The Media Usage Rights for a song downloaded from the URGE music
store during a free trial.

� The music and the backup licenses can
be transferred to up to two additional
computers, enabling up to three com-
puters to play the music. 

� Music may be burned to a CD up to
ten times. 

� You can export music an unlimited
number of times to a portable player
that supports WMA format. 

Other music stores have somewhat similar
license terms (check out the FAQs or Help
files before you buy digital music to find
out what the rules are for any particular
online music store). If you download

Digital rights management (DRM) is
designed to prevent the unauthorized
copying of digital content, primarily digital
music. When you “purchase” a song from
a digital music store, you are actually pur-
chasing a license to use that music in
ways authorized by the vendor. For exam-
ple, music purchased from the Wal-Mart
music service (http://musicdownloads.wal-
mart.com) has the following features:

� Music is stored using the 128-bit WMA
(Windows Media Audio) format
secured with DRM. 

� Music can be downloaded to a single
computer. 

DRM and Digital Music Downloads
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Creating Playlists
Whether you want to turn your PC into the 21st-century equiva-
lent of a stereo with a stack of LPs or preparing to populate your
portable media player with this week’s favorite songs, playlists
are how you’ll do it.  You can start the playlist creation process in
any of the following ways:

� Create a blank playlist—Click Library, Create Playlist. The
newly created playlist is, of course, blank. To fill it in, drag
songs, individually or in selected groups, to the Playlist pane.

� Play Favorites—This option creates a playlist of songs with a rating of
3-stars or higher. Select a category from your music library (from the
Navigation pane) and click the Play Favorites link that appears in the
List pane.

� Create an Auto Playlist—Click Library, Create Auto Playlist. In the New
Auto Playlist dialog, you can create a playlist that includes both music
and other media on your system. Click the plus (+) sign next to Music
In My Library to get started.

In the first set of criteria, you can select by album, artist, bit rating, vari-
ous date-related settings, ratings, how often the music has been
played, and others. Supply additional information as prompted. Add
criteria as needed to select just the media you want.

doesn’t take long with today’s high-speed
rewritable DVD drives, and the music you
rip yourself has no DRM strings attached
to it. More importantly to many, there are
also quality advantages to creating your
own digital music collection, too, especial-
ly if you have a good home theater setup:
the music you purchase from an online
store is often ripped at bitrate settings that
may be acceptable for playback on a
portable player, but won’t sound as good
as your rips will when you create them at
a higher bitrate.

music through a subscription service or
during a free trial of a music store, addi-
tional restrictions on usage may apply
(see Figure 8.15 for a typical example).

DRM’s job is to make sure that the usage
limitations in the license you purchase for
digital music are enforced. For example, if
you transfer a DRM-protected song to
more computers than you’re permitted,
the song just uses up space on the second
computer’s hard disk—it won’t play. 

How can you avoid DRM hassles, legally
(and ethically)? Rip your own CDs! It

TIP

If the Playlist pane isn’t

visible in WMP 11, click

the left arrow next to the

Search box at the upper-

right corner of the WMP

display.
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Use the And Also Include feature to include other types of
media, including pictures, TV shows, and videos to your
playlist. You can select additional criteria customized for each
type of media. 

Use the Apply the Following Restrictions feature to limit the
total size of your playlist by number of items, duration, or
total size. Figure 8.16 shows a typical auto playlist that
includes music, video, and picture elements. When you click
OK, the playlist is stored, starts playing, and is listed in the
center pane of WMP.

After you create a playlist, you can enjoy it on your computer or
transfer it to a portable media player. 

To save your playlist for reuse, click Save Playlist and provide a
name when prompted. Your new playlist appears in the Playlists
section of the left pane in WMP. To open an existing playlist, dou-
ble-click it and it appears in the central pane. To edit a playlist,
double-click it and click the Edit link in the playlist pane (see
Figure 8.17).

To clear the contents of your current playlist, click the X next to
the playlist. To remove an individual song or move it up or down
in the playlist, right-click the song and select an action from the
context menu that appears.

TIP

To grab an entire album

for your playlist, click the

album name in Songs or

Album views and drag it

to the Playlist pane. To

create a playlist of your

favorite group or artist,

select the Artist view and

drag the artist to the

Playlist pane. To create a

genre playlist, select

Genre view and drag

your favorite genre to the

Playlist pane. To create a

“greatest hits of the

decade” or “top hits of

the year” playlist, select

Year view and drag the

decade or the year to the

Playlist pane. 

Figure 8.16
Working with auto playlists.
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Figure 8.17
Retrieving and playing a playlist from the Playlists section of the left pane

Portable Media Player Support
With so many digital music and video players on the market, and no short-
age of downloadable music services, it can be confusing when it’s time to
select a player or service. Microsoft takes the guesswork out of selecting

players for use with Windows Media Player. As long as the player
is on the Plays for Sure list available at
http://www.playsforsure.com/FindPortableDevices.aspx or its
package includes the Windows Media Playsforsure logo, it works
with WMP.

Playlists in left

pane

Click to edit

current playlist

Clear playlist

contents
3

2

1

1
2 3

TIP

Wondering what music

services work with Plays

for Sure? Go to www.

playsforsure.com to find

music stores, services,

and devices that work

together with each other

and with Windows Media

Player.
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� Imports non-DRM content from
Windows Media Player and iTunes,
including WMA, MP3, AAC music;
JPEG photos; WMV natively, MPEG-4
and H.264 video via conversion

However, Zune does not work with DRM-
enabled music from any source other than
the Zune Marketplace. In other words,
Plays for Sure doesn’t apply to Zune, even
though both are from Microsoft! And, it
doesn’t work with WAV or WMA Lossless
file formats either (so much for maximum
audio quality fans).

Zune may (repeat, may) make sense for
digital media newbies and for those who
have digital media collections ripped from
CDs they own. However, the inability of
Zune to work with music purchased from
third-party music stores makes it useless
for anyone with a large collection of pur-
chased tracks—unless you like buying the
same music twice!

Learn more about Zune at Microsoft’s offi-
cial Zune website, http://www.zune.net. 

The new Microsoft Zune digital media
player brings a confusing combination of
advanced features and annoying limita-
tions to the digital music world.

On the plus side, Zune (available in
several colors!) features:

� Support for video, pictures, and music 

� 3-inch color LCD working in portrait or
landscape mode

� 30GB storage

� Integrated FM tuner (never miss “All
Things Considered” again!)

� Wireless Zune-to-Zune sharing

� Integrated 802.11b/g Wi-Fi wireless
Ethernet 

� Magnetic earphones that automatically
pause the unit when they’re discon-
nected (Steve Jobs, call your office!)

� Automatic monitoring of specified
folders for new and changed content

What’s Up with Microsoft Zune?

Managing and Transferring Media to Your
Portable Player
When you connect a supported portable media player to your PC for the
first time, Vista displays an AutoPlay message from which you can click
Play Using Windows Media Player to, from this point forward, automatic-
ally play the media already transferred to the player as soon as it’s con-
nected to your Vista PC.
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If you want to automatically play the media on the player when
you insert it, click the Always Do This… check box before clicking
Play. If you want to transfer media to or from the player, close
the AutoPlay dialog and start WMP 11 manually.

After you start WMP 11 and connect a portable media player, you
may see a Windows Media Player–Device Setup dialog. Click the
Sync This Device Automatically if you want to automatically syn-
chronize the device with the playlists in the right pane. Use the
Add button to move playlists to the Playlists to Sync pane on the
right or the Remove button to move playlists to the Available
Playlists pane on the left. Click Finish when you’re done.

After starting WMP 11, select the portable media device from the
left menu. If it already contains media, you will see a view appro-
priate to the media type. In the upper-right corner, a dialog dis-
plays the total capacity of the device and the amount of space

remaining (see Figure 8.18). If part of the capacity bar turns red,
as in Figure 8.18, the playlist is larger than the device’s capacity.

WARNING

WMP 11 may recognize a

flash memory storage

device as a portable media

device. You may see a

prompt asking you whether

you want to clear the con-

tents of your device to

make room for new media.

Unless you have a burning

desire to lose all your data

on the device, answer No

to this question.

Selected media

player

Current capacity

Remaining space

Switches to next

portable device

Next portable

device
5

4

3

2

1

Figure 8.18
Preparing to synchronize media with an RCA Lyra portable media player.

If your portable player doesn’t have any room for new content or doesn’t
have enough room for the entire playlist (as in Figure 8.18), you can shuffle

1

5

3

2

4
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music to the player (wiping out its current contents), or manually
delete music on the player to make room for new content while
keeping your favorite tracks around for another day. During the
synchronization process, each track in the sync list is displayed in
the Sync Results view, along with its status.

To dump unwanted content from your portable player, select the
portable player, open the appropriate view, select the content
you want to delete, and press the Del key on your keyboard.
When prompted to confirm, click Yes.

Manual File Synchronization
To synchronize content from WMP 11 to your portable player, you
can manually drag songs, albums, or playlists to the Sync List
pane at the right (refer to Figure 8.18), or click the shuffle music
link. To synchronize manually, make sure the player is selected,
open the appropriate view, select the items, and drag them to the
Sync List. When you’re ready, click Start Sync to complete the
transfer.

During the transfer process, Media Player displays a list of tracks
to be transferred, along with an animated progress bar for each
track so that you can keep track of what’s been transferred and
what’s left to do. At the end of the process, the Status column
should list each file as Synchronized to Device. The Playlist col-
umn indicates the playlist(s) you selected. If you selected individ-
ual songs or albums not in a playlist, the Playlist column lists
Files You Added for those items.

Shuffling Music to Your Player
The process of synchronizing the contents of your portable play-
er can be run in two ways: manual or automatic (also known as
shuffling). Shuffling automatically transfers media from a playlist
to your player. If you aren’t shuffling a specific playlist to your
portable player, you can click the Click Here link in the Sync List
pane (which replaces the Playlist pane on the right side of the
WMP interface. 

To start the process, click Shuffle Now. This option automatically
replaces the media on your player with the media in the Shuffle
list. The status dialog above the Sync List shows how much
space remains on your player. If the capacity bar turns red, your

TIP

If you’re working with a

lot of playlists and a

device that’s not big

enough to handle them

all, click the Shuffle What

Syncs check box shown.

WMP 11 will take care of

the details for you.

TIP

If your flash-memory

player has been upgrad-

ed with a flash memory

card, the card may be

displayed as a separate

drive letter in WMP 11

and in My Computer.

Click Next Device (refer

to Figure 8.18) or select

the drive letter corre-

sponding to the addition-

al memory device, then

click Start Sync to syn-

chronize files.

TIP

To delete an entire

album’s tracks at one

time from your portable

player, right-click the

album title and select

Delete.
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Sync List is too large for the remaining capacity of your player
(see Figure 8.18).

When you click Shuffle Now, you may be asked to click Yes to
continue. If you’re not absolutely sure that the music on your
device is backed up elsewhere, click No. During the process, the
music on your player is deleted to make room for new music.

A progress bar appears as the previous contents of your player
are deleted. Then a dialog listing all the tracks in the shuffle list

appears, and as each track is transferred the status changes (see
Figure 8.19). When there is no more room on the device, the Shuffle
process stops, listing the files that were transferred as well as those that
were not.

TIP

If the Sync List or other

list items aren’t visible,

click the Layout options

menu and select Show

List Pane.

Tracks that were

successfully shuf-

fled to the

portable device

Tracks that didn’t

fit

Tracks removed

from device

File being con-

verted during

shuffle to device

4

3

2

1

Figure 8.19
Shuffle lives up to its name, randomly copying songs from different
albums in no particular order to your player.

If you prefer automatic synchronization but want to select specific criteria,
right-click the icon for your portable player and select Set Up Sync…. Use
the Device Setup dialog to select options for automatically synchronizing
the device and selecting playlists to automatically synchronize, based on
music ratings, frequency of play, and other criteria. 

4123
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Automatic synchronization is enabled if the Sync This Device
Automatically check box is enabled. The Available Playlists pane
contains playlists you can select for synchronization. By default,
playlists in My Playlists are selected. You can also select Sync
Playlists from the pull-down menu for this pane.

Use the Priority arrows to move the selected criterion higher or
lower in the list. Click the Shuffle What Syncs check box to ran-
domize music. Use the Add button to move selected items from
My Playlist or other playlists to the Playlists to Sync category.
Use the Remove button to remove a criterion or playlist from the
dialog.

If you’re not satisfied with WMP 11’s default automatic sync crite-
ria, build your own. To create a new automatic playlist, click the
New Auto Playlist button and specify a name, criteria, and
restrictions, such as limiting the playlist to the capacity of your
player. Don’t forget to enter a better name than Untitled Auto
Playlist. Click OK when you’re finished.

To configure advanced auto synchronization options for your
portable media player, right-click its icon and select Advanced
Options. This opens the Sync tab of the properties sheet for your
player.

The Sync tab, shown in Figure 8.20 A, has options for starting
synchronization automatically, setting up folders, and reserving
space for other programs.

Click the Quality (see Figure 8.20 B) tab to adjust the quality
levels for music, video, and TV shows when transferred to your
player. By default, the greatest compression level (smallest size)
is selected for both types of media, and media recorded at a
higher quality is converted automatically during the transfer
process. The default is suitable for use with small flash-based
players, but if you’re using a hard disk-based player with plenty
of space, you may prefer to click the Select Maximum Quality
Level radio button for each type of media supported by your
player and use the slider to adjust the quality level. 

WARNING

Using Shuffle is easy, but it
doesn’t give you a lot of
control over what is copied
to your portable device. If
you’re album-oriented,
rather than song-oriented,
you may see the contents
of different albums mixed
together, and songs from
an album in a different
order than on the original.

To get more control out of
how Shuffle works, click
the Sync List link and
select options such as
clear the current list, sort
by various criteria (Track
Title, Album, and so on),
save playlist, or start the
shuffle process (Shuffle
List Now).

TIP

If your digital media play-
er is assigned a drive let-
ter by Windows and you
want to save space in
your player’s storage for
use as a removable
media drive or for use by
other programs, adjust
the Reserve Space…
slider shown in Figure
8.20 A to provide the
desired amount of space
for other uses.
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Figure 8.20

The options available on the Quality menu reflect the media types that your
player supports. If you can’t select an option, the device doesn’t

permit you to change the quality for that option.

Feature Rating: Device Synchronization

Burning a CD or DVD 
You can burn any media in your library (except for media whose
DRM settings prohibit burning) to a CD or DVD. Music can be
burned to an Audio CD (suitable for playback in a boombox or set-
top DVD player as well as a PC) or to a Data CD or DVD. This type
of disc is designed primarily for playback in a computer with the
appropriate CD or DVD drive but also works in many recent DVD

set-top boxes. 

To start the process of making a music CD, start WMP, select Music, open
the Burn tab and insert a writable CD. Then drag songs from your library
into the Burn List area at the right side of WMP 11 (see Figure 8.21), or click
the link to burn the current contents of the Now Playing view. Click Start
Burn to start the burning process.

A

B

WARNING

Because WMP 11 normally

reduces audio and video

quality during synchroniza-

tion to enable you to store

more content on your play-

er, feel free to rip your

media at the highest-

quality settings. 

Advanced Sync

options.

Configuring a digital

music player to use

128Kbps WMA digi-

tal audio for better

audio quality than

the default 64Kbps.

B

A
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Figure 8.21
Preparing to burn a music CD.

During the burn process, WMP 11 converts each song into a CD
audio track. A progress bar appears for each song during the
transfer progress. At the end of the process, all tracks are listed
as Complete. WMP 11 finalizes the disc and ejects the media
when the process is complete.

To create a CD or DVD containing MP3 or WMA tracks, click the
drop-down arrow on the Burn tab and select Data CD or DVD
from the Burn menu. 

By default, WMP 11 ejects the disc after burning it, and uses vol-
ume leveling to adjust the volume of each track (for balance).
Clear the check boxes in the Burn menu to disable these options.
To change additional settings, such as how to arrange the media
on the disc, or whether to convert MP3 or WMA audio to store
more on a disc, click More Options to open the Burn Options dia-
log (refer to Figure 8.7 A, p. 188).

The burn process works similarly for other types of media.
However, if you want to burn video or pictures to a CD or DVD,
be sure to choose Data CD or DVD as the media type.

Feature Rating: Burning CDs and DVDs

TIP

If you are burning CDs for

use in older boom box or

portable CD players,

make sure you use a

media type compatible

with those devices. Older

players may not be com-

patible with rewritable

CD (CD-RW) media, and

some might not work well

with certain combina-

tions of reflective layer

and dye combinations on

recordable CD (CD-R)

media.
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Playing Video in WMP 11
DVD support is the big news about WMP 11. Yes, you can finally use WMP
to play your favorite DVDs without installing a third-party DVD decoder.
Naturally, WMP 11 also handles other popular formats, such as Microsoft’s
native WMV format, the popular AVI format, and movies created with
Windows Movie Maker. To work with video in WMP 11, select Video from
the media types menu in Library view.

Figure 8.22 illustrates the All Video view of the Video Library.

Figure 8.22
The All Video view of the Video Library, displaying sample videos provided
with Windows Vista.

You can view videos by Genre, Actors, Rating (1–5 star or unrated), All
Video (as in Figure 8.22), and Recently Added.

When you select the Rating view, WMP 11 displays two views at once, My
Ratings (at top), and Auto Ratings (based on the number of times you play
a video) below that. You can select videos based on either rating system.
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Playing Videos
You can play videos in the same ways as photos and music:

� Select one or more videos and click the Play button.

� Right-click a video or selected videos and select Play.

� Create a playlist.

To create a video playlist, drag one or more to the Playlist area at
the right of the WMP 11 interface.

Playing DVDs with WMP 11
The biggest news in WMP 11 is its capability to play DVD video.
If you’re satisfied with WMP 11’s integrated DVD decoder’s fea-
tures and performance, you won’t need to install a third-party
DVD decoder program. To play a DVD, just insert it into your
system’s DVD drive. If an AutoPlay menu appears, select Play DVD Video
Using Windows Media Player. On Vista versions that include Media Center,
Media Center is also listed as a playback option.

If AutoPlay does not appear, or you stopped playback, open WMP 11, select
Other Media as the media type, go to Library view, click the icon to display
the contents of the DVD, and click the Play button.

Use your mouse to select scenes, subtitles, and other features. To view the
movie in full-screen mode, click the Full Screen icon in the lower right-hand
corner of the WMP 11 interface (or press Alt+Enter).

Use the DVD icon to the left of the Player controls to select special DVD
playback options, including audio and language tracks, menus, camera
angles, capture image, and to update DVD information.

To jump directly to a favorite scene, right-click it in the Library view of the
DVD and select Play. To play only selected scenes, select the scenes you
want to see, right-click the group, and select Play. (You cannot drag scenes
from a DVD to the Playlist.)

Enabling and Using DVD Playback Restrictions
To block WMP 11 from playing DVDs with undesired MPAA ratings, you
need to enable Windows Vista’s Parental Controls for user accounts. Click
Library, More Options and select the DVD tab. Click Change in the DVD

TIP

Don’t forget that you can

mix and match media in

your playlist! Select the

media type you want to

play, drag over the items

to the playlist, select

another media type, drag

over some more items,

and continue until you

have the playlist you

want. Use Save Playlist

to save your list.
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Playback Restrictions section of this tab and choose the maximum rating
you want to play (see Figure 8.23).

Figure 8.23
Selecting PG-13 as the maximum MPAA rating allowed for DVD playback
within WMP.

Click OK. If the User Account Control permissions dialog appears,
click Continue to proceed. If you haven’t configured your Vista
user accounts for use with parental controls, Vista reminds you
that these controls must be set up properly to enable this option. 

When any user (standard, administrator, or guest) tries to play a
DVD (see next Caution) that exceeds the playback restrictions set
on the system, a ‘Press Yes to Continue’ dialog should appear
(see Figure 8.24 A). Administrators can just click Yes and the
movie starts. However, User Account Control kicks in if the cur-
rent user is a standard user or a guest: these users must provide
the password for the listed administrator. If they don’t, they’ll see
a “This movie will not play” message (see Figure 8.24 B). Th-th-
that’s all, folks!

� For detailed coverage of parental controls and user
accounts, see “Managing User Accounts and Family
Safety,” Chapter 14, p. 329.

NOTE

Only standard user

accounts are affected by

DVD playback restrictions.

To make sure DVD play-

back restrictions work

properly, make sure the

users you want to restrict

have standard accounts.

Also, keep in mind that

some DVDs don’t support

this feature.

11_0789735865_ch08.qxd  7/27/07  10:09 AM  Page 212



MAXIMUMPC 213

MASTERING WINDOWS MEDIA PLAYER 11

Figure 8.24
WMP 11 blocks movies it recognizes with a rating higher than
permitted.

If WMP 11 doesn’t recognize your DVD, you can use the Find
DVD Info option from the right-click DVD menu to search for
DVDs by title. You can also edit the information retrieved, or add
information if the DVD is not in the database.

Feature Rating: Parental Controls

WMP 11 and TV Recordings
Windows Media Player isn’t just a platform for DVD video. You
can use WMP 11 as a player for TV recordings made with
Windows Media Center (.DVR-MS file format), a feature found in
both Windows Vista Home Premium and Windows Vista
Ultimate. 

� To review the differences between Windows Vista editions,
see Chapter 2, “Windows Vista Versions.” To learn more
about Windows Media Center, see Chapter 9, “Windows
Media Center the Vista Way.”

To play an individual TV recording, select it and click the Play
button on the WMP 11 player controls.

A

B

WARNING

Before you get lulled into
thinking that WMP will
always stop your kids from
watching Teenage Killer
Zombies from Space or
other unsuitable drek, keep
in mind that DVD Playback
Restrictions work only for
DVD movies that WMP 11
recognizes as having sup-
port for DVD playback
restrictions. Unfortunately
for concerned parents,
there are plenty of films
from all types of vendors
that don’t support this fea-
ture. Bottom line: If you
don’t want the kids watch-
ing stuff for grownups, lock
up the DVDs. Don’t expect
WMP 11 to do your parent-
ing job for you.

This DVD sup-

ports playback

restrictions

(parental level

controls).

No administrator

password?

Show’s over!

B

A
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TV recordings are organized into the following views:

� Recently Added

� All TV

� Series

� Genre

� Actors

� (Star) Rating

If you want to edit the information used to categorize a recording, select
the view you want to change, right-click the recording, and enter the cor-
rect information. Figure 8.25 demonstrates how to change a recording’s
genre from Unknown to Documentary. There’s no pull-down menu of
choices, so enter whatever text you want to use for classifying a recording.

Figure 8.25
Editing the genre used for classifying a recording.

To add recorded video to a playlist, you can drag it to the Playlist pane at
the right side of the WMP interface and use the Save Playlist button to save
the playlist. You can also right-click a recording and select Add to Untitled
Playlist or Add to and select Now Playing or a specific playlist.

Feature Rating: TV and Video Recording Support

Media Sharing and Your Home Network
One of the big features of the separate Media Center Editions of Windows
XP was the ability to share your media files across a network. However,
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even if your version of Vista does not include Media Center capabilities,
WMP 11 can share files across a network and play media from network
shares as well.

However, WMP won’t share or use shared media unless you enable this
feature. To get started, click the Library top-level menu and select Media
Sharing…, or open the Library tab on the Options menu (refer to Figure 8.5)
and click the Configure Sharing button. Either method opens the Media
Sharing dialog you see in Figure 8.26.

Figure 8.26
The Media Sharing dialog enables you to share media and play back
shared media on other PCs.

To play shared media on other devices (PCs, Xbox 360 game consoles, net-
work storage, and so on), make sure that Find Media That Others Are
Sharing is selected. To share media with other devices, make sure that
Share My Media is selected.

Click the Networking button to open Vista’s Network and Sharing Center. If
you cannot see other users’ libraries, or they can’t see yours, make sure the
network is properly configured.

� For information about setting up and configuring your network, see
Chapter 12, “Building a Home Network the Windows Vista Way,”
page 289.

Windows Media Player Tips and Tricks
Although Windows Media Player 11 has more goodies than ever before,
sometimes it can be difficult to figure out the easiest way to get something
done. Use the tips and tricks in this section to make WMP even easier
to use.
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Playback
� You don’t need to create a playlist to play several media items. Just

select them in the Library view, right-click the selected items, and
select Play.

� To play an entire album or DVD, right-click any track or chapter and
select Play All.

� Unless you’re running a dual-core or quad-core processor (both of
which handle multitasking extraordinarily well), you can improve DVD
playback by making sure that you’re not running other programs at the
same time. You can also use the Performance Options tab to fine-tune
performance settings.

� If you want to play music while viewing your pictures without down-
loading a visualization, start your music in WMP 11 and then open up
your Pictures folder and click the Slide Show button.

� For a more interesting slideshow, download the Picture Viz I or Picture
Viz II visualizations and play your music. These provide interesting pic-
ture transitions without leaving WMP 11.

� To optimize audio playback quality, turn on SRS WOW effects in the
Enhancements menu of the Now Playing tab.

� If you don’t use visualizations and use WMP 11 only for music play-
back, enable Allow Screen Saver During Playback.

� If you frequently play media on network folders or removable media
drives, enable the option to add those folders or drives to your library
to save time.

CD and DVD Burning 
� The older the device you plan to use to play burned CDs, the more like-

ly it is that CDs burned at the fastest speed might not play properly.
You can choose from four speeds: Fastest, Fast, Medium, and Slow. Try
using the next slower speed to burn media and then test it in the
device if you have problems with your device not recognizing the CD.
Keep going until you get to Slow.

� Use volume leveling only when it makes sense. Although it can save
you from a lot of knob-twisting to adjust the volume during playback, it
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can diminish the impact of quiet passages contrasted with louder pas-
sages in audio tracks. If in doubt, burn the CD with volume leveling dis-
abled and enabled and see which result you like better.

� Rewritable CD and DVD media (CD-RW, DVD-RW, DVD+RW) are great
for creating temporary mixes for use in your PC or in recent standalone
audio players, but they can be problematical for playback in older
devices. In those cases, use recordable CD or DVD media.

� If you want to create an enhanced CD (a disc that includes both data
and music), use a CD and DVD mastering program such as Roxio Easy
Media Creator or Nero 7 Ultra Edition Enhanced, instead of WMP 11’s
integrated burning feature.

DVD Playback 
� To fine-tune movie playback speed to make it easier to find your

favorite movie moments, open Now Playing, Enhancements, and select
Play Speed Settings. The range of playback speeds vary by film, and
you can change speed anytime you like.

� To eject a DVD directly from the left pane library view, right-click the
DVD and select Eject.

Video and TV Playback 
� For better performance when playing back WMV (Windows Media

Video) and other types of video, specify Enable DxVA Video
Acceleration on the Performance tab (refer to Figure 8.7).

� If you’re having problems with a loss of synchronization between audio
and video, you can drop frames (refer to Figure 8.7), but before you use
that option (which will lead to jerky-looking video playback), make sure
you have the latest video card drivers installed and are not running
any other programs. Sometimes, these changes can help improve
performance.

� If you’re having problems with playing streaming video from the
Internet, make sure you’re not downloading other files at the same
time, especially if you have a low-speed DSL (under 1Mbps), satellite
Internet, or (shudder) dial-up connection. Giving WMP exclusive access
to the connection can improve performance.
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� If you have no problems viewing streaming Internet media at home or
the office, but you’re having no luck when you use a public network
(such as a hotspot in an airport, library, or café), don’t blame the
Network Options tab. It’s more likely that you need to set up Windows
Media Player as an exception in the Windows Firewall.

� To learn more about the Windows Firewall, see “Using Windows
Firewall,” Chapter 14, p. 342.
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